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How to use 
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Functions 
 

Functions are tools in Excel that take one or more pieces of data and turn it into another piece of data. 

The input of a function may be a number, a date, a text string, a cell reference, a cell range, a formula, 

another function, or multiples of those. There are hundreds of functions available.  

 

You can find a list here: https://aka.ms/M3654J/ExcelFunctions.  

 

Here are the functions we covered in the various sessions (and a couple bonus ones). We did not 

introduce new functions in Session 03. 

 
 Session 1 Session 2 Session 3 Session 4 Session 5 Bonus 

SUM  ✅      

PRODUCT       ✅ 

RANDBETWEEN   ✅     

RANDARRAY      ✅  

UNIQUE      ✅  

COUNTIF      ✅  

COUNTIFS       ✅ 

SUMIF       ✅ 

SUMIFS      ✅  

XLOOKUP      ✅  

IF      ✅  

IFS      ✅ 

DOLLAR      ✅  

MONTH     ✅   

CONCATENATE      ✅  

AVERAGE       ✅ 

MEDIAN       ✅ 

MODE.SNGL       ✅ 

  

  

http://aka.ms/Microsoft365ForJournalists
https://aka.ms/M3654J/ExcelFunctions
https://support.microsoft.com/en-us/office/sum-function-043e1c7d-7726-4e80-8f32-07b23e057f89
https://support.microsoft.com/en-us/office/product-function-8e6b5b24-90ee-4650-aeec-80982a0512ce
https://support.microsoft.com/en-us/office/randbetween-function-4cc7f0d1-87dc-4eb7-987f-a469ab381685
https://support.microsoft.com/en-us/office/randarray-function-21261e55-3bec-4885-86a6-8b0a47fd4d33
https://support.microsoft.com/en-us/office/unique-function-c5ab87fd-30a3-4ce9-9d1a-40204fb85e1e
https://support.microsoft.com/en-us/office/countif-function-e0de10c6-f885-4e71-abb4-1f464816df34
https://support.microsoft.com/en-us/office/countifs-function-dda3dc6e-f74e-4aee-88bc-aa8c2a866842
https://support.microsoft.com/en-us/office/sumif-function-169b8c99-c05c-4483-a712-1697a653039b
https://support.microsoft.com/en-us/office/sumifs-function-c9e748f5-7ea7-455d-9406-611cebce642b
https://support.microsoft.com/en-us/office/xlookup-function-b7fd680e-6d10-43e6-84f9-88eae8bf5929
https://support.microsoft.com/en-us/office/if-function-69aed7c9-4e8a-4755-a9bc-aa8bbff73be2
https://support.microsoft.com/en-us/office/ifs-function-36329a26-37b2-467c-972b-4a39bd951d45
https://support.microsoft.com/en-us/office/dollar-function-a6cd05d9-9740-4ad3-a469-8109d18ff611
https://support.microsoft.com/en-us/office/month-function-579a2881-199b-48b2-ab90-ddba0eba86e8
https://support.microsoft.com/en-us/office/concatenate-function-8f8ae884-2ca8-4f7a-b093-75d702bea31d
https://support.microsoft.com/en-us/office/average-function-047bac88-d466-426c-a32b-8f33eb960cf6
https://support.microsoft.com/en-us/office/median-function-d0916313-4753-414c-8537-ce85bdd967d2
https://support.microsoft.com/en-us/office/mode-sngl-function-f1267c16-66c6-4386-959f-8fba5f8bb7f8
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Shortcut Keys 
 

In Excel, like most Microsoft applications, there are a lot of shortcut keys to make navigation and frequent 

tasks easier. You can find a comprehensive list here: https://aka.ms/M3654J/ExcelShortcuts  

 

Here is a list of some of the most useful. 

 

Shortcut Key Description Notes 

F4 Cycle among relative and absolute 

cell references 

This is the F4 key in the row of 

function keys. It is not the letter 

"f" key combined with the number 

"4" key. On some devices 

(especially laptops) you may need 

to use the key combo Fn + F4 

CNTRL+E Flash fill Use this key combination to tell 

Excel to fill in a series of cells 

based on a pattern it can discern 

from other cells. 

CNTRL+T Turn the dataset into a table Windows only. 

CNTRL+T Cycle among relative and absolute 

cell references 

Mac only. 

CNTRL+ select Select multiple disconnected cells 

and/or ranges 

Works in most apps 

SHIFT+ select Highlights the range between two 

selected cells 

Works in most apps 

CNTRL+A Select all the data on the sheet Works in most apps 

CNTRL+END Navigate to the last cell in the 

worksheet 

 

CNTRL+HOME Navigate to the first cell in the 

worksheet 

 

CNTRL+ arrow 

key 

Navigate to the edge of the dataset 

in the direction of the arrow you 

selected 

 

 

  

http://aka.ms/Microsoft365ForJournalists
https://aka.ms/M3654J/ExcelShortcuts
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Tasks 
Here’s a description of some of the tasks we covered in the five sessions of the Excel course. 

 

Add a worksheet 
An Excel file is called a workbook. Each workbook can have multiple worksheets that appear as tabs along 

the bottom of the window. 

 

To add another worksheet, go to the bottom of the current worksheet and look for the plus icon. It will be 

to the right of the individual sheet tabs. Select the plus button to add a new sheet.  

 

For more details, visit Insert or delete a worksheet (microsoft.com) 

 

Rename a worksheet 
You can choose a different name for each worksheet. Doing so will help you know what is on each sheet 

so you can keep track of your data.  

 

To rename a sheet, find the tab at the bottom of the window with that sheet’s current name, right-click on 

it, and choose Rename. 

 

For more details, visit Insert or delete a worksheet (microsoft.com) 

 

Color code a worksheet 
For some people, color coding sheet tabs makes it easier to identify them at a glance. When you assign a 

distinct color to a sheet name tab, that applies only to that sheet name tab; the color will not bleed into 

the rest of the document. 

 

To color code a sheet, find the tab at the bottom of the window with that sheet’s current name, right-click 

on it, choose Tab color, and then select a color. Select a different tab to see the color you just assigned 

 

For more details, visit Add a background color to a sheet tab (microsoft.com) 

 

Add two numbers 
To perform math in Excel, you start the opposite way we usually write math statements. Most of the time 

when we write out the formula to add 5 and 8, we would write “5 + 8 =” because in the US, we read from 

left to right. 

 

In Excel, it’s the opposite. We start with the equals sign. Once we type the equals sign, we are telling 

Excel, “Get ready. I’m about to ask you to do math, execute a formula, or calculate an instruction.” Unlike 

data we just put in Excel to look at, the equals sign tells Excel to do some work and not to show what we 

typed once we finish typing. Instead, Excel should show us the result of the task we asked it to do when 

we began with the equals sign. 

 

http://aka.ms/Microsoft365ForJournalists
https://support.microsoft.com/en-us/office/insert-or-delete-a-worksheet-19d3d21e-a3b3-4e13-a422-d1f43f1faaf2#:~:text=1%20To%20insert%20a%20new%20worksheet%2C%20do%20one,group%2C%20click%20Insert%2C%20and%20then%20click%20Insert%20Sheet.
https://support.microsoft.com/en-us/office/insert-or-delete-a-worksheet-19d3d21e-a3b3-4e13-a422-d1f43f1faaf2#:~:text=1%20To%20insert%20a%20new%20worksheet%2C%20do%20one,group%2C%20click%20Insert%2C%20and%20then%20click%20Insert%20Sheet.
https://support.microsoft.com/en-us/office/add-a-background-color-to-a-sheet-tab-440b28f2-3146-4dca-95df-3b9d43acbe59
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To add two numbers, like 5 and 8, together, choose a blank cell and type “=5+8”. Once you hit enter, 

Excel will show “13” in that cell. 

 

This is the basis of all the fancy stuff Excel can do. 

 

Add two cells 
Adding two cells, or rather, adding the values in two cells is a common task. If cell B2 has a 5 and cell B3 

has an 8, we can add them together.  

 

In cell B5, you can type =b2+B3. In B5, Excel will show the result of adding those numbers together. It will 

show “13”. 

 

If later you change the value in cell B2 to “11”, then Excel will update the value in cell B5 to “19”. 

 

Basic math 
To add cells in Excel, you can use the + character. 

To subtract cells in Excel, you can use the – character. 

To multiple cells in Excel, you can use the * character. 

To divide cells in Excel, you can use the / character. 

 

For more details, visit Use Excel as your calculator (microsoft.com) 

 

Resize a column 
Sometimes the data doesn’t fit in a column in Excel. Fortunately, you can resize one or multiple columns. 

There are several ways to do this. 

 

The simplest way is to select the column label in the column that’s the wrong size. So, if column B is too 

narrow, select the B that labels the column. Next, move your pointer to the boundary between that 

column and the one to the right. Your cursor will change to a vertical bar with arrows extending right and 

left. That tells you you’re in the right place. Then, double-click on that space. Excel will resize the column. 

 

For more details, visit Change the column width or row height in Excel (microsoft.com) 

 

Resize all columns 
You don’t have to resize columns one at a time. You can do them all at once.  

 

Select a cell anywhere in the sheet. Then use the shortcut CNTRL+A which will select all the data. Next, go 

to the boundary between any two columns at the top of the worksheet and double-click on that 

boundary. 

 

For more details, visit Change the column width or row height in Excel (microsoft.com) 

 

 

http://aka.ms/Microsoft365ForJournalists
https://support.microsoft.com/en-us/office/use-excel-as-your-calculator-a1abc057-ed11-443a-a635-68216555ad0a
https://support.microsoft.com/en-us/office/change-the-column-width-or-row-height-in-excel-4c0b8edc-4fb6-4af0-9374-7a953f48527b
https://support.microsoft.com/en-us/office/change-the-column-width-or-row-height-in-excel-4c0b8edc-4fb6-4af0-9374-7a953f48527b
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Change to currency 
You can tell Excel how to display data in your documents by telling Excel more about your data. You could 

put some numbers in a cell and just have Excel guess about what those numbers are, or you can refine it. 

You can tell Excel if those numbers are a date or currency, for example. Maybe they’re scientific notation. 

Or a percentage.  

 

To change a cell to a currency format, select the cell. Then go to the Home tab at the top of the screen. In 

the Number group, you’ll see a drop-down menu that says General. Select the drop down and choose 

Currency. Now you should see it in dollars, if you have your localization settings set for the US.  

 

If you want to see pennies, too, then you’re done. If you’re dealing with large amounts and the decimals 

don’t matter, you can make them go away. Look for the button below that drop down menu. It will have a 

.00 on the top of the button, and below that, you’ll see an arrow pointing to the right and a .0. When you 

hover over that button, the tool tip will say Decrease decimal. Select that twice to make first the pennies 

and then the dimes disappear. 

 

There is also a format called Accounting. That’s similar to Currency but defaults to accounting standards. 

For example, it will put the currency symbol at the far left of the cell instead of to the immediate left of the 

number. Try both to see what works best for you. 

 

For more details, visit Available number formats in Excel (microsoft.com) 

Toggle Absolute vs relative references 
Cell references are cell names that appear in other cells. For example, if you are in cell B3 and the formula 

in there is =A6+A10 then the cell references are A6 and A10.  

 

If you copy the formula in B3 to cell B4, Excel thinks, “Oh, you made a copy of this formula one row down. 

You must want the formula in the new place to refer to other places that are also one row down.” 

 

So now, the formula in B4 will be =B6+B10. If that’s what you wanted, great. You’re done. You used a 

relative cell reference and when pasted, Excel updated the references to a new location relative to where 

you pasted it. 

 

Another way to look at it is that in the original formula, Excel didn’t see the cell references as A6 and A10. 

It understood them relative to the location where the formula lived in B3. So, Excel saw the formula as 

“=(one row up, 3 columns to the right)+(one row up, 7 columns to the right)” and that’s what Excel pasted 

when you copied and pasted the formula to cell B4. Excel grabbed the relative reference. 

 

If you don’t want Excel to do that, and instead you want Excel to keep those cell references referring to 

the original cells when you copy and paste the formula, you need to use an absolute cell reference.  

 

The easy way to do that is to select the cell reference and press the F4 key to toggle to Absolute mode. 

When you do that, Excel will change A6 to $A$6. Do that for all the cell references you want to be 

absolute. 

 

You can make the entire cell reference absolute, just the row reference, or just the column reference. 

 

http://aka.ms/Microsoft365ForJournalists
https://support.microsoft.com/en-us/office/available-number-formats-in-excel-0afe8f52-97db-41f1-b972-4b46e9f1e8d2
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For more details, visit Switch between relative, absolute, and mixed references (microsoft.com) 

Insert as a table 
During the training sessions, we frequently converted a data set into a table. When you convert a data set 

to a table, you get a few advantages. Excel formats the table to maker it easier to read. It adds filter 

options at the top of the columns. When you add another row or column, Excel will expand the 

formatting. If you add a formula, Excel will copy it to the other rows. 

 

To make a data set into a table, select a cell within the data set, go to the Insert tab at the top of the 

window, and choose Table.  

 

Excel will ask you to confirm the range of the table, which is defined as the upper left cell by the lower 

right cell in the data set. You can adjust that if Excel guesses wrong (most likely due to blank columns or 

rows). Excel will also ask you to check a box if your dataset has headers (AKA labels) for the columns in 

your data. 

 

For more details, visit Overview of Excel tables (microsoft.com) 

 

Sort in a table 
To sort data within a table, select the drop-down menu in the header label for the column you want to 

sort by. Excel will know you want to sort all the rows together, so it doesn’t break your dataset. From 

there, you can sort ascending/descending, oldest/newest, A-Z, etc. based on the type of data in those 

columns. 

 

Filter in a table 
Filtering hides rows within a table without deleting them.  

 

To filter within a table, select the drop-down menu in the header label for the column you want to filter 

by. Then clear the check mark from the item you want to hide. Or, if you only want to see one or two of 

the items in the list, remove the check mark from the “Select all” box and then just select the ones you 

want to see.  

 

For more details, visit Filter data in a range or table (microsoft.com) 

 

 

Insert a PivotTable 
To insert a PivotTable, select a cell within the data set, go to the Insert tab at the top of the window, and 

choose PivotTable. Confirm the table, data set, or range of cells you want to be used for your PivotTable, 

and then choose whether you want your PivotTable in the current worksheet or a new worksheet. 

 

For more details, visit Insert a PivotTable (microsoft.com) 

 

http://aka.ms/Microsoft365ForJournalists
https://support.microsoft.com/en-us/office/switch-between-relative-absolute-and-mixed-references-dfec08cd-ae65-4f56-839e-5f0d8d0baca9
https://support.microsoft.com/en-us/office/overview-of-excel-tables-7ab0bb7d-3a9e-4b56-a3c9-6c94334e492c
https://support.microsoft.com/en-us/office/filter-data-in-a-range-or-table-01832226-31b5-4568-8806-38c37dcc180e
https://support.microsoft.com/en-us/office/insert-a-pivottable-18fb0032-b01a-4c99-9a5f-7ab09edde05a


9 http://aka.ms/Microsoft365ForJournalists Revised 2023-02-07 

 

Drag to copy 
You don’t always have to copy and paste when you want to copy and paste. You can select a cell or a 

group of cells and drag to copy | paste or extend. 

 

Select the cell, and look at the lower right of the black frame around the cell you selected. You should see 

a square. That square is the selection handle. Select and drag in a direction to copy the formulas in that 

cell to the other cells or to tell Excel to repeat the pattern evident from the selected cells. 

 

Use Auto Fill 

With Auto Fill, Excel will put data into cells based on a sequential or a repeating pattern. Patterns might 

include things like: 

• 1, 2, 3, 4 

• 3, 6, 9, 12 

• Monday, Tuesday, Wednesday 

 

To use it, select a cell or cell that have the seed of the sequence, then grab the selection handle. Drag the 

selection handle in the direction you want Excel to fill. 

 

For more details, visit Fill data automatically in worksheet cells (microsoft.com) 

 

Use Flash Fill 
Flash Fill lets Excel fill in data based on a pattern it sees in your data. For example, if you have a list of 

names in column A in First Name Last name format, and you want to convert that to Last Name, First 

Name in Column B you can use Flash Fill 

 

Select a cell in column B next to one of the names in column A. Type the name from column A in the 

format you want in column B. Hit enter, and then hit CNTRL+E. Excel will identify the pattern and convert 

the rest of the data in column A. 

 

For more details, visit Using Flash Fill in Excel (microsoft.com) 

 

Enable Data Validation 
Data validation lets you restrict the information someone puts in a cell. You can restrict it to text, dates, 

integers, specific lists, and more. When you choose to restrict a cell to a specific list, Excel creates a drop-

down menu for that list in that cell. That’s what we did in our training session. 

 

To use data validation, select the cells you want to restrict. Then, go to the Data tab at the top of the 

window. Go to the Data Tools group along the tab and look for the button that has a drawing of two 

boxes, one above the other. On top of the top box, you’ll see a green check mark. On top of the bottom 

box, you’ll see a do not enter symbol. It should be labeled Data Validation. Select that button. 

 

Find the drop down under “Allow” and choose “List.” In the box that says source, type the address or 

range for where your list appears in the spreadsheet. In our example, we pointed it to an array function 

with its spill area. 

 

http://aka.ms/Microsoft365ForJournalists
https://support.microsoft.com/en-us/office/fill-data-automatically-in-worksheet-cells-74e31bdd-d993-45da-aa82-35a236c5b5db
https://support.microsoft.com/en-us/office/using-flash-fill-in-excel-3f9bcf1e-db93-4890-94a0-1578341f73f7
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For more details, visit Apply data validation to cells (microsoft.com) 

 

Apply conditional formatting 
Conditional Formatting applies fonts, styles, colors, and fills to cells based on their values or the values of 

other cells in the workbook. 

 

To apply conditional formatting, select the cell to which it should apply. Next, go to the Home tab at the 

top of the window, go to the Styles group, and look for the button that looks like a grid with some red 

rectangles and a blue rectangle on top of it. It should be labeled Conditional Formatting. 

 

Choose the type of formatting you would like to apply. 

 

For more details, visit Use conditional formatting to highlight information (microsoft.com) 

 

Manage Conditional formatting rules 
You can customize your conditional formatting further, and even apply multiple rules to the same cells. 

 

Select the Conditional Formatting button on the Home tab, and choose Manage Rules. 

 

In the box that opens you’ll see a drop-down menu labeled Show formatting rules for.  

 

From here, you can look at the rules that apply to the current selection or a specific table or worksheet. Or 

you can look at the rules for the entire workbook and duplicate, edit, delete, or create as appropriate. 

 

For more details, visit Use conditional formatting to highlight information (microsoft.com) 

 

Access Charts 
To access charts in Excel, first select the data you want to be part of the chart. Then, go to the Insert tab 

at the top of the window, find the Charts group in the middle of the window, and choose Recommended 

Charts or pick a specific type of chart, 

 

For more details, visit Create a chart from start to finish (microsoft.com) 

 

  

http://aka.ms/Microsoft365ForJournalists
https://support.microsoft.com/en-us/office/apply-data-validation-to-cells-29fecbcc-d1b9-42c1-9d76-eff3ce5f7249#:~:text=Try%20it%21%3A%201%20Select%20the%20cell%28s%29%20you%20want,to%20display%20the%20message%20when%20the%20user%20selects
https://support.microsoft.com/en-us/office/use-conditional-formatting-to-highlight-information-fed60dfa-1d3f-4e13-9ecb-f1951ff89d7f
https://support.microsoft.com/en-us/office/use-conditional-formatting-to-highlight-information-fed60dfa-1d3f-4e13-9ecb-f1951ff89d7f
https://support.microsoft.com/en-us/office/create-a-chart-from-start-to-finish-0baf399e-dd61-4e18-8a73-b3fd5d5680c2
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Formulas from Training Session 
 

Over the course of the five sessions, we used a variety of functions and formulas 

Session Formula What it does 

1 =D4+D5 Adds the value of cell D4 to the value of cell D5 

1 =SUM(C2,C3,C4,C5,C6,C7,C8) Adds the value of C2, C3, C4, C5, C6, C7, and C8 

1 =SUM(C2:C8) 
Adds the value of cells C2 through C8 together. It's a simplified 

version of the previous formula. 

1 =C2*I2 Multiples the value of C2 and I2 

2 =F2/E2  Divides the value of F2 by the value of E2 

2 =D2/K2 Divides the value of D2 by the value of K2 

2 =L2*C2 Multiples the value of C2 and L2 

3 =RANDBETWEEN(1,2000) Generates a random integer between 1 and 2,000 

4 =MONTH(E2) Extracts the month of the year from the date in cell E2 

5 =COUNTIF(B:B,"Dem") Counts the number of times the string "Dem" appears in column B. 

5 =SUMIFS(C:C,B:B,"REP") 
Adds the values in column C if the same line row in column B contains 

the string "Rep" 

5 =DOLLAR(K4,0) 
Takes the number in K4 and converts it to dollar currency with zero 

decimal places. 

5 
=DOLLAR(SUMIFS(C:C,B:B,"REP"),

0) 

Adds the values in column c if the same line row in column B contains 

the string "Rep" and converts it to dollar currency with zero decimal 

places. 

http://aka.ms/Microsoft365ForJournalists
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Session Formula What it does 

5 =If(E2>=270,"Won","Lost") 
If the value in E2 is 270 or higher, it returns the string "Won". If it's not 

270 or higher, it returns the string "Lost" 

5 =IF(E2>=$L$8,"Won","Lost") 
If the value in E2 is equal to or higher than the value in L8, it returns 

the string "Won". If it's not 270 or higher, it returns the string "Lost" 

5 

=XLOOKUP(D2,'Inflation 

Calculator'!$A$2:$A$10,'Inflation 

Calculator'!$B$2:$B$10) 

Looks up the value in D2 in column A on the Inflation Calculator tab. 

If it finds it, it returns the equivalent value from column B on the 

Inflation Calculator tab 

5 =C2*H2 Multiplies the value in C2 by the value in H2 

5 

=C2*XLOOKUP(D2,'Inflation 

Calculator'!$A$2:$A$10,'Inflation 

Calculator'!$B$2:$B$10) 

Looks up the value in D2 in column a on the Inflation Calculator tab. If 

it finds it, it returns the equivalent value from column B on the 

Inflation Calculator tab and multiplies that by the value in C2 

5 =RANDBETWEEN(12,20) Generates a random integer between 12 and 20 

5 =RANDARRAY(5,3,12,20,1) 
Generates five rows and three columns of random integers between 

12 and 20 

5 =UNIQUE(B:B) Lists all the unique values in column B 

5 =UNIQUE(D:D) Lists all the unique values in column D 

5 =K10# 
Used in data validation, this pulls in all the data in K10 and its spill 

area 

5 =J10# 
Used in data validation, this pulls in all the data in J10 and its spill 

area 

http://aka.ms/Microsoft365ForJournalists
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Session Formula What it does 

5 

=CONCATENATE("Candidates 

from the ",N11," party spent 

",DOLLAR(SUMIFS(H:H,B:B,N11,D

:D,N10),0)," adjusted for inflation 

on the ",N10," Presidential 

Election.") 

This takes the party in N11 and the election year in N10 and adds up 

all the spending amounts in column H where the row matches the 

party and year. It then converts that number to dollar currency and 

puts the whole answer into a sentence. 
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